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Disclaimer

This manual and the information contained herein are the sole property of EVS Broadcast
Equipment SA and/or its affiliates (EVS) and are provided “as is” without any expressed or
implied warranties, including, but not limited to, the implied warranties of merchantability
and fitness for a particular purpose. In particular, EVS makes no warranty regarding the
use or the consequences of use of this manual and the information contained herein.
Furthermore, EVS may not be held liable for any direct or indirect, incidental, punitive or
consequential loss, damage, cost or expense of any kind whatsoever and howsoever
resulting from the normal or abnormal use of this manual and the information contained
herein, even if advised of the possibility of such loss, damage, cost or expense.

While every effort has been made to ensure that the information contained in this manual
is accurate, up-to-date and reliable, EVS cannot be held liable for inaccuracies or errors
that may appear in this publication. The information in this manual is furnished for
informational purpose and use only and subject to change without notice.

This manual cancels and replaces any previous versions thereof.

Copyright

Copyright © 2003-2015 EVS Broadcast Equipment SA. All rights reserved.

This manual may not be reproduced, transcribed, stored (in a database or an retrieval
system), translated into any language, computer language, transmitted in any form or by
any means — electronically, mechanically, printed, photocopied, optically, manually or
otherwise —in whole or in part without the prior written consent of EVS.

Trademarks
All product and brand names are registered trademarks and trademarks of EVS or of their
respective owners.

Improvement Requests

Your comments will help us improve the quality of the user documentation. Please send
improvement requests, or report any error or inaccuracy on this user manual by e-mail to

doc@evs.com.

Regional Contacts

You will find the full list of addresses and phone numbers on the following webpage:
http://www.evs.com/contacts.



mailto:doc@evs.com
http://www.evs.com/contacts
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User Manuals on EVS Website

The latest version of the user manual, if any, and other user manuals on EVS products can
be found on the EVS download center, on the following webpage:
http://www.evs.com/downloadcenter.
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What's New?

In the User Manual the icon has been added on the left margin to highlight
information on new and updated features.

The changes linked to new features in version 2.1 are listed below.

Application Monitor now writes files to the AppData folder instead of it's own
executable folder.

What's New?
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1. About the Application

Application Monitor is used in the IP2Archive setup to monitor the status of the
(automatic) IP2Archive applications and their tasks and also the status of particular
database jobs.

1. About the Application
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2.

3.1.

Installing the Application

See the IP2Archive Installation manual for more information on how to install the
application.

Starting the Application

After Installation

To start the application after installation, proceed as follows:

1. Double-click the Application Monitor icon E on the server desktop to start the
application. You can also launch the application by double-clicking the executable file
(.exe) in the installation folder.

The application splash screen appears while the application logs into the
IP2Archive database.

IPE Archive

Version: 01.05

-
. Application Monitor

=V5

Logging on to ..

Then, the Settings window appears allowing you to configure the application. See
section "Configuring the Application" on page "23".

2. Installing the Application
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3.2. After Configuration

To start the application after it has been configured, proceed as follows:

1. Double-click the Application Monitor icon E on the server desktop to start the
application. You can also launch the application by double-clicking the executable file
(.exe) in the installation folder.

The application splash screen appears while the application logs into the
IP2Archive database.

IPE Archive

Version: 01.05

Application Monitor

Logging on to ..

i Login

Username:

Login

To be able to log into the application, you need to belong to a user group that has a role
which allows to use the application.

2. Enteryour username and password and click Login. The main window of the
application opens.
You get an error notification if:
» you have entered a wrong username or password.
¢ Login

lzername:

3. Starting the Application 3
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* you have omitted your username.

¢ Login

lsernarne:

P oy A

» you have insufficient user rights.
i Login
Username: BBO

Passn

» youruser account has expired.
¢ Login

sername: BEO

F. .d : BT

3. Starting the Application
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3.3. Version and License Check

Introduction

The version of the application and the validity of the application license will be checked
when the application logs into the IP2Archive database at startup. The status of the
version or the license that is returned is displayed on the application splash screen.

Version and License Statuses

The following version and license statuses can be returned:

Status Description Color Action Required
Current The actual version of the application. no No action required.
color

The application starts
automatically.

Outdated | A newer version of the application red Click OK to start the
exists, but this version can still be application at once.
used.

By default, the
The application version that should be application starts
installed is displayed. automatically after 10
seconds.

Obsolete | A newer version of the application red Click OK to continue.
exists and must be used. This version
may not be used anymore. The application shuts

down.

The application version that should be
installed is displayed.

Undefined The version of the application is not black ' Click OK to continue.

defined in the IP2Archivedatabase.
The application shuts

down.

Beta A test version. blue Click OK to start the
application.

By default, the
application starts
automatically after 10
seconds.

3. Starting the Application 5
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Status Description Color Action Required

License The license period is about to expire. It | orange Click OK to start the

About to is shown in how many days the license application at once.
Expire will expire.
By default, the
Contact your system administrator or application starts
check the License Controller manual. automatically after 10
seconds.
License The license period has expired. The red Click OK to continue.
Expired date when the license expired is
displayed. The application shuts
down.

Contact your system administrator or
check the License Controller manual.

No Valid There was no valid license found inthe  red Click OK to continue.
License database.
The application shuts
Contact your system administrator or down.
check the License Controller manual.

Maximum  The maximum number of instances red Click OK to continue.

Licenses <NUMBER OF LICENSES> for the

Reached license has been reached. The application shuts
down.

Contact your system administrator or
check the License Controller manual.

6 3. Starting the Application
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4. User Interface

4.1. Main Window

General Description

The main window gives you an overview of the (automatic) IP2Archive applications and
database jobs whose status is monitored by Application Monitor.

1 2

p Archive Controller -ation Server  [C:\Program Files\EYS Broadcast \IP: y-1310:38:00 | & |-,
Deep Archive Manager  |APPSRVA 1767 |application Server  |C:\Program Files\EYS Broadcast Equipment\IP24\Deep|Running 08-May-13 10:55:14 | [ [
Deep Archive Sync APPSRVA1767 | Application Server  (C:\Program Files\EYS Broadcast Equipment|IP2A\Deep|Running 08-May-13 10:55:08 | [ :]
Deep Archive Sync Contr |APPSRVA 1767 |application Server  |C:\Program Files\EVS Broadcast EquipmentiIP24\Deep|Running 08-May-13 10:55:49 | [ |
IP2Archive Communicaton APPSRVA 1767, | Application Server  |C:\Program Files\EVS Broadcast Equipment\IP2AIP2A [Running 08-May-13 10:55:53 | & [
Deep Archive Controller |APPSRVA 1767 |application Server  |C:\Program Files\EYS Broadcast EquipmentiIP2A\Deep|Running 08-May-13 10:55:41 | [ :]
| Application Monitar APPSRVA1767 | Application Server  [C:\Program Files\EYS Broadcast Equipment{IP2A\Appli |Running 08-May-13 10:55:54 | & |
File Transfer Daemon APPSRVA 1767, | Application Server  |C:\Program Files\EVS Broadcast Equipment|IPZA\File T|Running 08-May-13 10:55:36 | [

1| Assign archive storage 3 storage for the archive requests 15-Jan-13 12:00:41 = =]

2|Start archive Start the archive requests 15-Jan-13 12:00:41 = =

2|Check archive Check the progress of the archive requests ot dir 15-Jan-13 12:00:41 [=] =]

3
The table below describes the various parts of the main window:

Part Name Description

1. Menu bar The menu bar contains three menus: File, Settings and

Help.

2. Applications pane The Applications pane displays the (automatic) IP2Archive
applications and database jobs in the IP2Archive setup
whose status is monitored by Application Monitor. See
section "Applications Pane" on page "9".

&k Tasks pane The Tasks pane displays the tasks of the IP2Archive
application selected in the Applications pane. See section
"Tasks Pane" on page "10".

4. User Interface 7
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Menu Bar

The menu bar contains three menus: File, Settings and Help.

File Menu

The File menu contains two commands: Logout and Exit.

Click the File menu or use the keyboard shortcut keys ALT + F or F10 + F to open it.
Click Exit or use the keyboard shortcut key X to exit the application.

Click Logout or use the keyboard shortcut key O to log out of the application.

Settings Menu

The Settings menu does not contain any commands. It immediately gives access to the
application settings. Click the Settings menu or use the keyboard shortcut keys ALT + S
or F10 + S to access the settings.

Help Menu

The Help menu contains the following commands: Help, Context-Sensitive Help and
About.

With the Help command you can open the application help file.

With the Context-Sensitive Help command you can turn on or off the context-sensitive
help mode. In context-sensitive help mode, when you click a user interface item, help for
that item is displayed. You can also turn on or off context-sensitive help mode by pressing
F1.

With the About command the application about box can be opened. The about box
displays the application software version, the date until which the application license is
valid, the name and version of the database the application is logged on to and the login
name used.

Click About or use the keyboard shortcut key A to open the application about box.

IPE Archive

Version: O1.05

Application Monitor
Application: 2.1.6.0
Database: 01.05.00.0027
License: 02-MAR-2015

=N/

Legged on to [DatabaseName]

8 4. User Interface
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4.2. Applications Pane

General Description

The Applications pane displays the (automatic) IP2Archive applications and database
jobs in the IP2Archive setup that are monitored. Note that the applications and database
jobs displayed in the screenshot below might differ slightly from the ones in your specific
setup.

Applications
Last update

08-May-13 10:38:00
08-May-13 10:55:14
08-May-13 10:55:08
08-May-13 10:55:49
08-May-13 10:55:53
08-May-13 10:55:41
08-May-13 10:55:54
08-May-13 10:55:38

Machine name Machine description Path

APPSRVA1757.|Application Server  [C:iProgram FilesEYS Broadcast Equipment!IPZaiDeep Mot
APPSRVA1767.|Application Server
APPSRVA1767.|Application Server

# Application
Deep Archive Controller

Deep Archive Manager C:YProgram Files\EYS Broadcast EquipmentiIPZ4\Deep Running

s

Deep Archive Sync C:YProgram Files\EYS Broadcast EquipmentiIPZ4\Deep Running

Deep Archive Sync Contr APPSRVA1767. | Application Server
P2 Archive Cammunicator APPSRVA 1767, | Application Server

C:YProgram Files\EYS Broadcast EquipmentiIPZ4\Deep Running
Ci\Program Files\EYS Broadcast EquipmentiIPZALIP24 [Running

APPSRVA1767.|Application Server
APPSRVA1767.|Application Server
APPSRVA1767 |Application Server

Deep Archive Contraller C:\Program Files\EYS Broadcast Equipment)IP24iDeep|Running

C:\Praogram Files\EYS Broadcast Equipment) P24} Appli |[Running
C:\Program Files\EVS Broadcast Equipment)IP2A4File T|Running

Application Monitor

File Transfer Daemaon

EIEIEIEIED

Application and Database Job Information

Of each application and database job the following information is displayed:

Column Description

Application The name of the application instance or database job.

Machine Name The name of the machine on which the application instance or

database job is installed.

The description of the machine on which the application
instance or database job is installed.

Machine Description

Path
Status

Last Update

Alerts

il

The path of the application's executable file.

The status of the application or database job. See section
"Application and Database Job Status" on page "11".

The date and time the status of the application or database job
was last updated in Application Monitor.

The indication that an alert or notification will be sent when the
application or database job is not responding or when an error
has occurred.

The button used to open a configuration screen allowing you to
enter a name for the application or database job and to enable
and configure the sending of alerts. See section "Enabling
Alerts" on page "13".

4. User Interface



EVS Broadcast Equipment SA Issue 1.5.D - March 2015

4.3.

If you select an application, the tasks performed by that application will be displayed in the
Tasks pane below. See section "Tasks Pane" on page "10".

You can add, modify or remove a description of a particular machine in the settings. See
section "General Tab" on page "25"

The applications and database jobs are displayed in a grid. Application Monitor has a
number of features that allow you to customize the display of the data in the grid. See
section "Managing Grids" on page "16".

Tasks Pane

General Description
The Tasks pane displays the tasks performed by the application you selected in the

Applications pane. A task is an automatic job performed by the application. Each
application has one or more tasks.

Assign archive storage Assign a storage For the archive request Running 04-Apr-14 11:49:55

Start archive Start the archive requests Running 04-Apr-14 11:49:58
Check archive Check the progress of the archive requests Running 04-Apr-14 11:50:01

Task Information

Of each task the following information is displayed:

Column Description
Ord. The sequence number of the task.
Name The name of the task.

Description The description of the task.

Status The status of the task.See section "Application Task Status" on page
n 1 1 " i

Last Update The date and time the status of the task was last updated in
Application Monitor.

Def. Act. Indicates if the task is active by default at startup.

Active Indicates if the task is currently active.

The tasks are displayed in a grid. Application Monitor has a number of features that allow
you to customize the display of the data in the grid. See section "Managing Grids" on page
l|16".

10

4. User Interface
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S. Monitoring Applications and
Database Jobs

5.1. Application and Database Job Status

An application or database job can have one of the following statuses.

Status Description

Running The application or database job is running as it should.
Warning The application or database job reported a warning.
Error The application or database job reported an error.

Not Responding The application or database job is not responding.

Applications and database jobs that are running are highlighted in green.

The Application Monitor will highlight the application or database job in red when it cannot
report its “healthy” status via the database to the Application Monitor.

This happens in the following situations:

» The application or database job is switched off.

» The application or database job has become unresponsive.

» The application can no longer connect to the database (Oracle connection lost).

» The application or database job got an unexpected error and is able to report this error
status.

5.2. Application Task Status

An application task can have one of the following statuses:

Status Description

Running The task is running as it should.
Warning The task reported an warning.
Error The task reported an errror.

Not Responding The task is not responding.

Inactive The task is inactive by default.
Inactivated The task is inactivated, but should be active by default.
Activated The task is activated, but should be inactive by default.

The tasks that are running are highlighted in green.

5. Monitoring Applications and Database Jobs 11
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5.3.

The Application Monitor will highlight the task in red when the task cannot report its
“healthy” status via the database to the Application Monitor.

This happens in the following situations:

* Thetask is switched off.

* Thetask has become unresponsive.

» The task can no longer connect to the database (Oracle connection lost).

+ Thetask got an unexpected error and is able to report this error status.

Modifying the Name of Applications
and Database Jobs

If your IP2Archive setup has various instances of the same application, you can easily
make a distinction by manually modifying the name of each instance. You can also modify
the name of a database job.

To modify the name of an application instance or database job, proceed as follows:

1. Click the Configure Application button Eﬂ of the respective application or database
job.

The Configure Application dialog box appears.

re application

In the Application area, the Name field displays the name of the application instance
or database job as set in the IP2Archive database.

2. Modify the name and click the Save button.

The name of the application instance or database job will be changed in the
IP2Archive database and also in the Applications pane.

12

5. Monitoring Applications and Database Jobs
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5.4.

Enabling Alerts

Introduction

Application Monitor allows you to enable for each monitored automatic application and
database job in your IP2Archive setup the automatic sending of alerts. Application Monitor
will automatically send an alert when an application, application task or database job no
longer responds because of an error or because it has been shut down.

Once an alert has been sent for a particular application or database job, Application
Monitor will automatically disable the Alerts functionality for this application or database
job. This to prevent Application Monitor from sending a new alert every minute.

This allows you the time to check and solve the problem.

The Alert functionality can either be manually reenabled by you, or you can configure
Application Monitor to automatically reenable the Alert functionality after a preset time
interval.

If the problem gets solved, no alert will be sent anymore.

How to Enble Alerts

Note

The alerts will only be delivered if:

« the Mail Controlleris running

* you have specified the addressees for the alerts in the Global Settings.

To enable the Alerts functionality for a particular automatic application or database job,
proceed as follows:

1. Click the Configure Application button Eﬂ of the respective application or database
job.
The Configure Application dialog box appears.

2. (Only for database jobs) In the Allowed Idle Time field, enter the time (in hh:mm:ss)
a database job is allowed to be idle before Application Monitor will send an alert.

i Configure application

3. Toenable the Alerts functionality, select the Alerts Enabled check box. By default,
this option is disabled.

5. Monitoring Applications and Database Jobs 13
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4. Select:

o Automatically Re-enable Alerts After if you want Application Monitor to
automatically enable the Alerts functionality again a preset time interval after the
Alerts functionality was automatically disabled.

If this option is selected and the Alerts functionality is automatically disabled, an
extra field will appear displaying the actual time when the Alert functionality was
disabled and the actual time when the alert functionality will be re-enabled again.

o Alerts Have To Be Re-Enabled Manually if you want to manually re-enable the
Alerts functionality after it was automatically disabled.

The Tasks pane displays the name and a description of the tasks performed by the
application. It also shows how long a particular task is allowed to be idle before
Application Monitor will send an alert. Note that for a database job, this pane will be
empty.

5. (Only for applications) Modify the allowed idle of the desired tasks by entering a new
value in the Allowed Idle Time field.

6. Click Save to store the settings in the database.

In the Application pane the Alerts check box will be selected.

Sample Alerts

Below you will find two sample alerts that are automatically sent when an application or
database job is not responding because of an error or because it has been shut down.

The first sample alert indicates that on May the 8th at 10 o'clock the application DAC Test
was not responding. Since the option Automatically Re-enable Alerts After is selected
in the settings, a new alert will be send if the problem is not solved within the preset time
interval.

Process => Application monitoring

Type => Error

Timestamp => 08/05/2013 10:18:18

Code => 100

Message => Application DAC Test is in state 'Not responding'

If the problem is not solved within 02:00:00 from now, this e-
mail will be sent again.

14 5. Monitoring Applications and Database Jobs
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The second sample alert indicates that on May the 8th at 10 o'clock the application DAC
Test was not responding. Since the option Alerts Have To Be Re-Enabled Manually is
selected in the settings, a new alert will not be sent, even if the problem is not solved.

Process => Application monitoring

Type => Error

Timestamp => 08/05/2013 10:18:18

Code => 100

Message => Application DAC Test is in state 'Not responding'

This e-mail will not be sent again, even if the problem is not
solved.

5. Monitoring Applications and Database Jobs 15
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6.

6.1.

6.2.

6.2.1.

6.2.2.

Managing Grids

Introduction

In Application Monitor most of the data is displayed in grids. Each grid consists of a
number of columns containing specific information.

Application Monitor provides you a number of features to customize each grid.
Manipulating Columns

Adjusting the Width of Columns

The width of each grid column can be manually or automatically adjusted.

How to Manually Adjust the Column Width

To manually adjust the width of a particular column, drag the right or left border of the
column header until the column has the desired width.

To manually change the width of a column to fit its contents, double-click the boundary on
the right side of the column header.

If you hold your cursor over a column header border, it will change into a double-headed
arrow.

Al

Keep Online Expire Date .'TI:I:--:atiI:-n

How to Automatically Adjust the Column Width

To automatically adjust the width of a column to fit its contents, right-click the column
header, and then select the Best Fit option from the context menu.

To automatically adjust the width of all columns to fit their contents, right-click the column
header, and then select the Best Fit (all columns) option from the context menu.

Il Best Fit

Best Fit (all columns)

Reordering Columns

If you want the information in a grid to be displayed in a different order, you can change the
position of the columns. There are two ways to reorder columns.

16
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How to Reorder a Column Using a Drag-And-Drop Action

To reorder a column by directly dragging its header, proceed as follows:

1. Click the header of the column you want to move and hold down your left mouse
button.

2. Dragthe column header to the desired position in the grid.

Two arrows will indicate where it is possible to insert the column.

Status T

A black prohibition sign will indicate where the column cannot be inserted.

3. Release the left mouse button to insert the column.

How to Reorder a Column Using the Show/Hide/Move Button

You can also reorder the columns of a grid by using the Show/Hide/Move button:

1. Click E on the left side of the first column header.

A drop-down list containing the headers of the grid columns appears. The column
headers are listed in the order in which the columns are displayed in the grid. The first
header in the list is the leftmost field in the grid. The columns that are visible in the grid
are selected.

The headers in the screenshot below can differ from the headers available in your
application.

n Ord, Mamne

ripkion
# Status

2. Select a header and drag it to the desired position in the list. Green arrows will appear
indicating where you can insert the grid.

In the grid, the column will be moved to the new position.

6. Managing Grids 17
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6.3.

6.4.

Copying Data

To copy the data of a particular grid row to the Clipboard, proceed as follows:
1. Select the appropriate row in the grid.
2. Press CTRL+C.

Sorting Data

Each grid can be sorted according to the values in one of the columns. You can sort text
(from A-Z or from Z-A), numbers (from low to high or from high to low).

How to Sort Data by Clicking a Column Header

To sort the data in a particular column, click the column header once to sort the data in
ascending order. Click again to sort the data in descending order. An arrow next to the
column header indicates the sorting method.

sorted in ascending order
sorted in descending order

How to Sort Data by Using the Context Menu

You can also sort the data in a particular column by right-clicking the column header and
selecting the desired sorting method from the context menu.

%l Sort Ascending
El Sort Descending
Clear Sorting

To clear the sorting in a particular column, right-click the column header and select the
option Clear Sorting from the context menu.

18
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6.5. Filtering Data

You can filter the data in a grid by using two types of filters: by one or more values from a
particular column or by simple or complex criteria.

6.5.1. Filtering by Values From a Column

To filter the data in a particular grid by one or more values from a particular column,
proceed as follows:

1. Hold your cursor over the header of the column by whose values you want to filter the
grid, and then click the filter button.

A drop-down list opens containing all the column values.

2. Select the desired values.

Only the records that contain one of the selected values are displayed in the grid. At
the bottom of the grid a filter bar appears displaying the applied filter.

Customize...

< ¥ (Type = Opener)

3. Inthefilter bar, do one of the following:
o Clearthe check box next to the filter @ to undo it. Select the check box to apply
the filter again.
o Click I to undo the filter and close the filter bar.
o Click e to open a drop-down list containing previously applied filters.

o Click Customize to create a complex filter.

6. Managing Grids 19
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6.5.2.

Filtering by Criteria

Filters by criteria can be simple or complex:

Simple filters consist of one or two criteria and one Boolean operator (AND or OR).

Complex filters consist of more than two criteria and more than one Boolean operator
(AND, OR, NOT AND and NOT OR).

How to Create a Simple Filter

To create a simple filter, proceed as follows:

1.

Hold your cursor over the header of the desired column, and then click the filter button
appearing in the right comner.

From the drop-down list, select the option (Custom...).

The Custom Filter dialog box appears. Here you can enter the criterion or the two
criteria you want to filter the values of the selected column by.

Custom Filter

Use _ to represent any single character

Select the desired comparison operator from the first drop-down list.

A comparison operator is used in comparison criteria to compare two values.
Operators include: ‘equals’, ‘does not equal’, ‘is less than’, ‘is less than or equal to’, ‘is
greater than’, ‘is greater than or equal to’, ‘like’, ‘not like’, ‘is blank’ and ‘is not blank’.

For example, if you want to filter the values of a column by text that includes a certain
word, character or sign, you have to select the comparison operator ‘like’.

Enter text in the field next to the first drop-down list.
For example, if you want to filter by text that includes the letter ‘S’, type %S%.

The % wildcard can substitute for zero or more characters. The _character can
substitute for exactly one character.
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If you want to add a second filter criterion, select the desired Boolean operator. Select:
o AND, if both criteria have to be true;
o OR, if at least one of the criteria or both have to be true.

Select the desired comparison operator from the second drop-down list, and then enter
text in the field at the right.

Click OK to apply the filter.

Only the values matching the entered criterion or criteria will be displayed.

How to Create a Complex Filter

To create a complex filter, proceed as follows:

1.

Apply a simple filter to a grid or filter a grid by selecting one or more values from a list
of values. See above.

At the bottom of the grid a filter bar appears.

In the filter bar, click the Customize button.

A dialog box appears that allows you to create complex filters. The criteria of the
active filter are displayed in a tree structure. Here you can add extra criteria and
change the existing criteria.

? Fitter builder - [untitled.flt]

Filter <root:>

press the button to add a new condition

Do one of the following:

To add a new criterion, do one of the following:

o click the Press the Button to Add a New Condition button;
o click the Filter button and select Add Condition;

o click ' next to a criterion and select Add Condition.
To change a criterion, do one of the following:

o click a column header (green and underlined text) and select another value from
the list;

o click a comparison operator (dark red and underlined text) and select another value
from the list: ‘equals’, ‘does not equal’, ‘is less than’, ‘is less than or equal to’, ‘is
greater than’, ‘is greater than or equal to’, ‘like’, ‘not like’, ‘is blank’, ‘is not blank’,

‘between’, ‘not between’, ‘in’, ‘not in’;
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o click the dark blue text on the right of the comparison operator and enter another
value.

To delete a criterion, click the ! button to the left of the criterion and select the option
Remove Row.

To add a group of criteria, do one of the following:

o click ' next to a random criterion and select Add Group;

o click the Filter button and select Add Group.

To delete all criteria, click the Filter button and select the option Clear All.
Do one of the following:

o Toopen an existing complex filter, click Open;

o Tosave the current filter, click Save As;

o To confirm the changes and close the dialog box, click OK;

o Toundo the changes, click Cancel.

o Toapply the changes, click Apply.

At the bottom of the grid a bar appears which displays the components of the complex
filter. Note that if you have already created a custom filter in the past, you can reapply
it by clicking the current filter or the downward pointing arrow. A drop-down list
containing previous filters appears.
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7. Configuring the Application

7.1. Settings Window

Opening the Settings Window

The Settings window allows you to configure your application. The first time the
application is launched after it has been installed, the Settings window opens
automatically.

Settings

<~ Enter into edit mode

User settings Global settings System settings

General

The Settings window can also be accessed through the Settings menu.

Overview Setup Categories

The settings can be divided into two setup categories. In the Settings window, atab is
provided for each setup category. The table below briefly describes each setup category:

Setup Category Description
User Settings These settings can be configured by each individual user.
System Settings These settings configure the general functioning of the

application. They can only be configured by the system
administrator.
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Edit Mode

To be able to edit the System settings, you first have to enter a password.

To put the Settings window into Edit Mode, proceed as follows:

¢ Enter into edit mode

1. Click the Enter Into Edit Mode button
A dialog box appears.

Password Dialog

Enter password:

2. Enter the administrator password and then click OK.

The Settings window enters into Edit Mode.

Edit Mode

Note
Certain settings are read-only and cannot be configured. These can only be

modified in the Configurator application. Other settings have to be configured
locally.

Saving Settings

A Save button is provided which allows you to immediately save the changes you have
made to the settings. With the Cancel button you can discard the changes you have
made.
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7.2.

7.2.1.

7.2.2.

7.3.

7.3.1.

User Settings

Overview User Settings Subcategories

The User settings are divided into the following subcategories:
+ General

For each subcategory a tab is provided.

General Tab

The General tab displays the name of the servers on which the (automatic) IP2Archive
applications are installed that are monitored by Application Monitor. The names are
retrieved from the IP2Archive database.

With the Refresh List button you can retrieve the latest information from the IP2Archive
database. The list of machines will be updated in its actual state.

You can add a description to each server. The description you enter here will appear in the
Machine Description column in the Applications pane. See section "Applications Pane"
on page "9".

Global Settings

Overview Global Settings Subcategories

The User settings are divided into the following subcategories:
+ General

For each subcategory a tab is provided.
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7.3.2. General Tab

The General tab allows you to search for and specify the recipients or addressees for the
alerts that will be automatically sent by Application Monitor when an application or
database job is no longer responding in your IP2Archive setup. See section "Enabling
Alerts" on page "13".

How to Add an Addressee

To add an addressee, proceed as follows:

1. Inthe Relations pane, search for the contact you want to add as addressee for the
automatic alerts. Enter (part of) the name of the contact and/or the company and click
the Search button.

The companies and contacts that correspond to your query appear in the grid below.
The e-mail address of each contact is also displayed.

2. Double-click a contact to add him as addressee for the automatic alerts.

The contact is added to the Alerts grid. The Send Mail check box is automatically
selected.

How to Remove an Addressee

To remove an addressee again, do one of the following:
1. Select the contact and click the - sign.

OR

Double-click the contact.

2. Click OK to confirm your action.
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7.4.

7.41.

7.4.2.

System Settings

Overview System Settings Subcategories

The System settings are divided into the following subcategories:
+ General
*  Oracle Connection

For each subcategory a tab is provided.

General Tab

The General tab lists the IP2Archive applications and database jobs that are installed in
your IP2Archivesetup. It enables you to specify which applications, application tasks and
database jobs should be monitored by Application Monitor. Note that the applications and
database jobs displayed in the screenshot below might differ from the applications in your
specific setup.

If you select the Visible check box of a particular application, application task or database
job, it will appear in the Applications pane of the main window. See section "Applications
Pane" on page "9". Application Monitor will check the status of this application, application
task or database job.

To view the tasks of an application, click @. To hide the tasks again, click K.
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7.4.3. Oracle Connection Tab

The Oracle Connection tab allows you to configure the connection with the Oracle
database.

Oracle login
Login narne :
Ilze thiz login name

ze autologin

4 Application history

k.eep connection alive interval ; G0

{{1] tirne(z]

Entering the Database Name

In this field you have to enter the name of the database the application has to connect to.

If the Use This Database Name check box is selected, the name of the database will
automatically appear in the Oracle login dialog box at start-up.

Note that the database name will be automatically entered and the Use This Database
Name check box will be automatically selected when you log into the application for the
very first time.

Entering the Login Name

In this field you have to enter a login name. If the Use This Login Name check box is
selected, the login name will automatically appear in the Oracle login dialog box at start-
up.

Note that the login name will be automatically entered and the Use This Login Name
check box will be automatically selected when you log into the application for the very first
time.

28 7. Configuring the Application



USER MANUAL IP2Archive 1.5 Application Monitor — / —

Entering a Password

In this field you have to enter a password. If the Use Auto Login check box is selected,
the application automatically logs into the selected database at start-up. The Oracle login
dialog box does not appear.

Note that the password will be automatically entered and the Use Login check box will be
automatically selected when you log into the application for the very first time.

Checking Application History

By clicking the Application History button, you can open a chronological list of all
software versions of the application. To get more details about each version (creation
date, name of programmer, status, additional remarks), you have to click + next to the
version number.

Activating Keep Alive

If the option Keep Connection Alive is selected, a message is sent to the database at
regular time intervals to avoid idle connections from being closed by the firewall. These
intervals can be set by you.

Note that this option will be automatically selected when you log into the application for
the very first time.

If the option Try to Reconnect if Keep Alive Fails is selected, the application will try a
number of times to reconnect with the database.

If the option Report Status in Database Everytime Keep Alive Timer Triggers is
selected, the status of the connection is reported in the database each time the Keep Alive
Timer sends a trigger to send a Keep Connection Alive message.

Testing the Oracle Connection

The Test Oracle button allows you to check the validity of the database name, login and
username you entered.

If these data are valid, then the following message appears next to the Test Oracle
button: ‘OK’.

If the login name or password is invalid, then a message box appears with the following
message: ‘ORA-01017: invalid username/password; logon denied’.

If the database name is invalid, then a message box appears with the following message:
‘ORA-12154:TNS: could not resolve the connect identifier specified’.

If you omit the password, then a message box appears with the following message: ‘ORA-
01005: null password given; logon denied’.

If you do not enter a database name, login and usermame, then a message box appears
with the following message: ‘ORA-12560: TNS: protocol adapter error’.
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You can also check the software version of the application by clicking the Test Oracle
button. If the software version is up-to-date, then the following message appears:
‘Current— The Current Version'. If the software version is outdated, then the following
message appears: ‘Unknown Version Application! Please contact the EDP department.’

If you close the Settings window without testing the validity of the database name, login
and username you just entered, then a message box appears.

Information x

or not working properly.

If you click Yes, then the Settings window is closed and the original values are restored. If
you click Cancel, then the Settings window does not close and you can test the values by
clicking the Test Oracle button.

If you change the current database settings, test the connection and then close the
Settings window, a message box will appear.

Information

If you click Yes, the application is stopped and closed. A manual restart will be required.
Click Cancel to continue.
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